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Introduction:  Getting started on a new lesson

1.  Open Microsoft PowerPoint and you will see the screen 

below. (diagram 1) PowerPoint 2013 defaults to 

Widescreen but I prefer Standard.  Click on Design and 

then the Slide Size drop-down, and click Standard. 

Diagram 1

Diagram 2

I prefer to start with a blank page format so I choose this by clicking 

on this option, from the Home tab, Layout drop-down. (diagram 2)
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2.  To add a new blank slide to your presentation, click on 

the New Slide option, when on the Home tab. (Diagram 3)  

From the same menu you can also choose Duplicate 

Selected Slides which can be very useful for making similar, 

yet progressive staged activities in the presentation of new 

language phase of a lesson.

Diagram 3

Diagram 4

Insert table
Insert text box

Insert picture Insert WordArt

3.  You can also insert a new slide from the Insert tab, as well 

as a text box, a picture, a table, a shape,  video or audio.  

We will look at the most relevant functions as they occur in the 

making of a languages lesson.  Different from previous 

versions of PPT, each insert step triggers a new set of options 

that apply to that item. 

Insert audio

Insert video



Shows grid (to help guide 

positioning of pictures & text)

The option to see the grid lines on your slides for guidance 

is found within the View tab.

Diagram 5
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In addition, handy 

guide lines appear 

when you place 

pictures or shapes 

near to each other on 

a slide, to help you 

line them up.



Section 1:  Presenting new language

1.  The presentation of new language can involve many different activities 

and it would not be desirable to follow exactly the same formula in 

every lesson.  That said, there are a number of staged presentation 

activities that are in the repertoire of all languages’ teachers and that 

lend themselves particularly well to PowerPoint.  I list them separately 

here and then detail how to make each type of activity in this section:

a. Students hear the new language presented by the teacher linked to a 

visual image and on a coloured background to reinforce the gender (if 

nouns).

b. Students hear the new language presented by the teacher, linked to the 

same visual image and indicate their comprehension by identifying the 

number or the letter of the language item.

c. Students see the visual image and hear two alternatives presented by the 

teacher, indicating their comprehension and practising production by 

recalling the correct option. (This can be made more challenging by 

presenting more options to choose from and/or varying the speed of 

presentation).

d. Students repeat the language items after the teacher, seeing the visual 

image once more.

e. Students respond chorally ‘Es verdad’ or ‘Es mentira’ to the teacher’s 

presentation of the language items in response to the visual stimulus.  (The 

speed of appearance/disappearance of the visual image can be 

increased to increase the demand in terms of language recognition in this 

activity.)

f. Students respond to the question ‘¿Qué falta?’ and produce the language 

for the visual image that has disappeared.  

g. Students identify the item as it appears or requested by the teacher by 

number.
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a. Students hear the new language presented by the 

teacher linked to a visual image and on a coloured 

background to reinforce the gender (if nouns).

1.  I aim to introduce 6, 9 (or very occasionally12) new vocabulary 

items in a lesson.  These numbers of items work well visually and 

spatially as well as being challenging if the objective is 

independent production and retention of new language, plus its 

combination with existing language, by the end of the lesson.

2.  I count up the number of items of each gender and plan to divide 

my slide up into blocks of colour accordingly.  If I have 9 items, 3 

masculine, 3 feminine and 3 neuter (in Gm) I will insert / draw 3 

rectangles of the same size.  (diagram 6)

Click in the top left hand corner and 

drag the cursor down to make a 

rectangle shape that fills  about a 1/3 

of the slide.  When you click off, your 

shape is automatically shaded in blue. 

(Diagram 7). To change the colour fill, 

make sure it is selected and then choose 

a different colour by clicking to the right 

of  the paint tin icon on the tool bar at 

the top right of the screen. (Diagram 8)

Diagram 6

Diagram 7 Diagram 8
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For example, you can use www.google.co.uk and select Images

before you search – this gives a lot of images BUT be careful about 

copyright, particularly if you might share your work more widely.

Alternatively you can harvest images from existing PowerPoints or 

Word documents.  If I am doing this, just open up the document 

containing the pictures and use Ctrl C and Ctrl V to insert the 

pictures into the new PowerPoint lesson. 8

3.  Next just copy and paste the 

existing rectangle to make the 

other two (or however many you 

need).  If the shape is selected 

(has white round dots at the 

corners) then you can simply do 

Ctrl C to copy the shape and Ctrl 

V to paste. (Ctrl X deletes the 

item selected). Use the same 

method as before to colour fill the 

shapes.  (Diagram 9)

Diagram 9

4.  Now you need to insert the visual images you want to represent 

your new language.  You may already have the images you need 

stored on your computer.  If so, select Insert  Pictures to browse.  

If not, you can either choose Insert  Online Pictures, or simply 

have a browser open.  

Diagram 10

http://www.google.co.uk/


It is getting harder to source the best pictures copyright free, but here 

are some useful royalty free sites:

https://openclipart.org/

https://www.wpclipart.com/http://www.phillipmartin.info

/clipart/homepage.htm

TIP!

If you copy and paste the picture and it has an unwanted background 

colour, select Format  Colour  Set transparent colour and then 

click onto a section of the background.

Diagram 11
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Move the images into the 

appropriate positions according 

to their gender and the order in 

which you want to present them.  

It is useful to present a few 

easier words (cognates) first but 

not to leave all the most difficult 

language to the end.

Diagram 12

NB: if copying and pasting straight into the PPT from the internet 

results in a grainy image, you can often improve the quality by 

saving first to your computer and then importing.

5.  Now choose how you want the 

pictures to appear.  To begin this 

process, select the Animations

tab.  When you click on a picture, 

the greyed out options turn green 

and you can select an appearance 

animation effect.  

All animation options are 

available across the top.  

If you prefer the old 

format, you can choose to 

see them in Animation 

Pane.

Diagram 13

Diagram 14
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6.  With this first presentation activity, you probably want each 

image to appear separately on your mouse click.  I think that a 

multitude of whizzy effects adds nothing to the learning at this 

point (if ever!) and it saves time to have a couple of favourites that 

you use for this activity.  I use Fade for picturesand Wipe (left to 

right) most often for text. 

The quickest way to animate all the pictures using the same effect 

but appearing one by one is to select them all on the slide (click 

and draw round them with the arrow so that they all show the white 

dots).  Click on the effect you want, then go to the Start option (top 

right) and choose ‘on click’. This means that the pictures will appear 

one by one.  

NB:  You need to check the order of appearance at this point and 

you can easily adjust the order of individual pictures by clicking on 

them in the Animation Pane menu and dragging them up or down. 

(see diagram 15)

Diagram 15



7. At this point your first slide is finished.  But more importantly

you have most of what you need to make all the other presentation 

slides very much more quickly than this first slide.

b. Students hear the new language presented by the teacher, 

linked to the same visual image and indicate their 

comprehension by identifying the number or the letter of the 

language item.

1. To create this

activity, begin with a 

new blank slide.  Then 

insert a table (either 2 

x 3, 3 x 3 or 4 x 3) 

either by clicking on the 

insert table icon.

Diagram 16

2. Resize the table by clicking and holding on a white dot in the 

corner and dragging it out to fill the whole screen.

Diagram 17
NB:  Notice that a new 

set of menu options has 

appeared above the 

slide.  Often you will 

want the table to be 

clear.  Click the down 

arrow and all the 

format options will 

appear.
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Diagram 18

I usually choose this 

option.

3. To number/letter the boxes either just type into them or

select the WordArt symbol from the tool bar and make numbers or 

letters in this way.  The most efficient way to replicate is to format one 

as you want it (style, colour, size) and then Ctrl C and Ctrl V to create 

a copy.  

4. Select, copy and paste all the pictures from your first slide

into this new one.  Whilst still selected, go to the Animation tab and 

click ‘None’ to remove the animation from all the images all at once.  

Then adjust the positions of the images so that they fit nicely in the 

boxes.

Diagram 19
Diagram 20
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TIP:  It can work really well to use numbers and letters other than the 

first 12 in the alphabet.  The function of the activity is thereby 

broadened to include the revision of other essential language. Even 

KS4 classes sometimes need this consolidation.

c. Students see the visual image and hear two alternatives 

presented by the teacher, indicating their comprehension and 

practising production by recalling the correct option. (This can 

be made more challenging by presenting more options to 

choose from and/or varying the speed of presentation)

1. Insert a new slide and

choose blank presentation as 

the format.  To create this 

type of activity, it is most 

useful to be able to see lots 

of space around the slide, so 

choose 40% using the sliding 

bar on the bottom right shown 

in diagram 21.

Diagram 21

2. Now copy and paste

the same pictures in from a 

previous slide and remove 

any animations that are 

already attached to them.  

(see previous instructions 

for how to do this.)  Move 

the pictures to positions just 

off the edge of the slide.  

See diagram 22.

Diagram 22
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3. The idea here is to animate each picture to come on and

off the screen using a motion path.  This is obviously not the only 

way to present the ‘alternatives’ activity but it does provide visual 

variety and keeps students’ attention and their concentration levels 

high.  

Begin by clicking on 

one image to select 

it.  Then select 

Animation.  Scroll 

down to Motion 

Paths.  And select an 

option.  Line is the 

easiest to use.

Diagram 23

4. Select Line option and click and drag a line down from your

selected picture to a position off the edge of the slide.  You get a 

‘ghost’ image that shows you where your picture will end up. 

Repeat for all other images, choosing the order you wish them to 

appear.
Diagram 24
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d. Students repeat the language items after the teacher, seeing 

the visual image once more.

For this activity simply make a new slide, copy and paste the images 

in again and animate to appear in a different order this time for 

variety.

e.     Students respond chorally ‘Es verdad’ or ‘Es mentira’ to the 

teacher’s presentation of the language items in response to 

the visual stimulus.  (The speed of appearance/disappearance 

of the visual image can be increased to increase the demand in 

terms of language recognition in this activity.)

1.  Create a new slide, blank presentation format and copy and 

paste the pictures onto it again, removing any existing animation.  

The idea of this activity is to reinforce comprehension, involving the 

whole class at once.  It is not always necessary with higher ability 

students, but for lower ability groups, it provides a further 

opportunity for consolidation whilst maintaining their interest and 

involvement.  In terms of animation, the idea is to animate each 

picture to appear and then disappear.

2.  To animate, select a picture 

by clicking on it, choose 

Animation select the green 

entrance effect you want.  Then 

choose Add Animation from the 

task bar and select an exit (red) 

animation.  The result will be two 

animations, an entrance and exit 

for the same image, on two 

different mouse clicks.  Animate 

the remaining images in the same 

way.  

Diagram 25
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f.  Students respond to the question ‘¿Qué falta?’ and produce the 

language for the visual image that has disappeared.

g.   Students identify the item as it appears or requested by the 

teacher by number.

For (f) you can simply make a duplicate slide from (e) and then 

remove all the entrance effects leaving only the exit effects.  You 

can alter the order of animation to keep variety.

For (g) you can use either an earlier slide again or make a similar 

one, either within a numbered grid or on a plain background.  

Depending on how much support students need with gender, it may 

be useful to present the images again on the coloured backgrounds.

Diagram 26

You can see that you have done 

this when you see 2 animation 

boxes appear next to the image.
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NB: 2003 and 2007 versions of PowerPoint had more animations, 

including a Flash Once.  A very helpful user has created way to 

‘borrow’ the 2007 animations and apply them easily to 2013 PPT.  See 

here: https://community.articulate.com/discussions/articulate-

presenter/flash-once-in-powerpoint-2010

https://community.articulate.com/discussions/articulate-presenter/flash-once-in-powerpoint-2010


Section 2:  Practising new language orally

a1.    Students practise pronunciation and speed of recognition

further by a game, e.g. ‘Repite si es verdad, si no silencio.’ 

All pictures visible, the teacher points to one image and if s/he

says the TL for what it is, students repeat, if s/he says a different

item, students remain silent.  This is played as a contest between

the whole class and the teacher (first to 5 points).

You can use PowerPoint to present a variety of different activities 

ranging from whole class to pair work activities.  The method for 

creating the activity slides is the same as for the presentation 

activities detailed above. (a) and (b) below are examples of both 

whole class practice activities and pair work slides.

a2.   Students in Y7 use this set of prompts and visual images

to practise speaking about their break time routine in Spanish.

a3.    Students at KS4 use this

game board to practise speaking

for at least a minute on whichever

topic box they land on.  The die in

the centre looks like it’s being

rolled when you click it.

Diagram 27

Diagram 28



The advantage of this as a PowerPoint slide is the clarity of the pre-

prepared scoring grid and the letters that appear automatically 

when you click in the coloured boxes.  Once you have a master like 

this, you can easily change the categories and letters to make 

different versions for different topics and classes 19

a4.   It is very straightforward to create role play activities in

PowerPoint.  The first slide on the left is more structured and has

the questions inserted as sounds (covered later in the listening

section) with the English instruction given.  The second is

progression to a GCSE Higher Role play layout with prompts in the

TL only.
Diagram 29

a5.  This is just a PowerPoint

version of the alphabet

game, in which students 

work in groups, are given a 

letter of the alphabet and 2

minutes and have to come 

up with a word for each of

the 5 categories, gaining one

point for each..

Diagram 30



a6.  This is a PowerPoint

version of Trivial Pursuit. 

This is the master game

slide.  The 6 wheels

represent the class divided

into 6 groups and their

progress through the game

is shown by clicking on a

triangle according to the

colour key (top left) to fill in

the coloured piece once

they have answered

correctly in that category. 

(This effect is created using

triggers in the PowerPoint

program.)  It also works well

as an FLA activity with up to

6 students.

The coloured boxes can be 

hyperlinked to other slides with 

picture prompts to aid students to 

say an appropriate answer.  The 

categories and supporting slides 

can be easily changed to make 

new games.

Diagram 31

b1.    These two slides show two different ways to model a pair

work activity.  Diagram 32
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b2.   This is a game that works

best in pairs once

demonstrated as a whole class. 

Students have their own dice

and work in pairs to come up

with either an individual item

of vocabulary or a sentence

containing that item (can be

easily differentiated within one

class in the same lesson). The die 

is made using triggers.

Diagram 33

b3.   This is just a fun way to

structure any pair work that

you want to introduce into

your lesson.  Students play in

pairs against each other and

can either practise ‘batting’

individual items of

vocabulary to and fro until

one can’t think of any, or

they can be practising a

conversation or interview

with several exchanges.  

Diagram 34

Diagram 35

There are a lot of different speaking activities that can be built 

from one PPT slide.  Here are a few more examples.
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Creating triggers in PowerPoint 2010

Triggers are very useful when you want to have more flexibility in 

responding to students’ contributions.  With animation effects that are 

triggered in presentation mode rather than pre-set as a sequence, 

you can take answers in the order in which students present them.

One example of an activity type using triggers is a spontaneous talk 

activity, in which a photo is hidden behind several triggered boxes, 

each showing a statement.  To reveal part of the photo beneath, 

students need to create a question in the language that would 

generate the statement as an appropriate answer.  When they do 

this, the teacher clicks on that square, which disappears to reveal 

what is beneath.

Diagram 36 This one is a Wipe Out 

game slide.  Students have 

to produce the TL for the 

story narration phrases 

given in English.  When 

they do, the teacher 

reveals what is underneath 

by clicking on the square.  

This square is triggered to 

disappear revealing either 

a tick or a W beneath.

A tick is a point for the team 

and they continue playing.  A W 

means no point and play passes 

to the other team.  The team 

with the most ticks wins.
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Triggers can be applied to make most language elicitation activities 

more responsive and interactive.  This slide uses 6 triggered shapes 

covering the 6 animals that were part of the language introduction 

activities earlier in this guide.  Students have the option to guess 

what is behind any of the shapes each time rather than work through 

in a particular order.

1.  Draw a shape (Insert 

Shapes)

2.  Colour the shape (right hand 

side – Shape Fill)

3.  Right click on the shape and 

select ‘Edit text’ to label the 

shape with a letter/number.

4.  Go to Animations. Select an 

exit effect.  

5.  Under the Animation Pane, 

choose Trigger.  Pull down the 

tab to ‘on click of’ and select 

from the list of possibilities.  Most 

often you want the effect to be 

triggered by clicking the shape 

itself, (usually last on the list).

6.  Copy/paste the shape – edit 

the text.  

7. In PPT 2013 the trigger seems 

to copy correctly automatically, 

but do keep checking that it is 

triggered by itself, and not one 

of the other shapes.

The trigger icons look like little 

lightening bolts.

Diagram 37
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Here are a few example of PPT 

activities made using triggers:

1.  Battleships

A whole class version of a game 

students can then play in pairs.  The 

language to be practised can 

obviously be varied, but it helps if the 

aim is to create full sentences using 

information from vertical and 

horizontal axes, giving you a ‘target 

square’ where there may or may not 

be a hidden battleship. Each square is 

concealed by a triggered shape that 

will disappear when clicked.

2.  Treasure Hunt

This is the same principle.  Here it is 

coins (1 point) and one treasure chest 

(worth 5 points) that are hidden.  By 

having letters / numbers to give 

coordinates, teachers can vary the 

questions they ask, making this slide 

usable for any topic / class.

3.  Family fortunes

A prediction game where students try 

to anticipate the 7 sentence answers to 

a question they have recent learnt and 

practised in class. Each team has 3 

lives (opportunities to predict 

wrongly).

4.  Blockbusters

A question is given for each letter and 

two teams compete to cross the board, 

side to side (blue team) or top to 

bottom (white team).



Section 3:  Practising new language aurally

1. You can achieve a very quick transition between activities.

2. You can trim the audio creating smaller sections to differentiate 

for the ability of your class.

3. You can repeat effortlessly and without having to exit the 

presentation.

4. Using a cordless mouse in the classroom, you can play the 

listening material from wherever you are in the room – you are 

not tied to the CD player at the front.

5. You can pre-prepare slides with the answers so that after the 

activity it is very simple to mark and students have a visual 

reference and will not ask you to repeat answers.

6. If students find the activity difficult, you can easily do an 

example with them first, showing the answers and how to record 

them in the table.

One of the most useful features of PowerPoint is that you can insert 

sounds into your presentation and control their playback within your 

presentation.  This has several advantages:

Previously, if you wanted to divide the audio, you needed some 

additional software to edit the listening material e.g. Audacity, before 

inserting into PowerPoint.  However, PowerPoint 2013 automatically 

adds a playback bar.  This allows you to control start, stop and volume 

whilst within presentation mode.  There is now therefore much less of a 

need to edit the audio. However, there is also the facility to trim the 

audio within PowerPoint itself.
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This is how to do a simple audio file insert (MP3).  

Diagram 38 From the Insert menu, choose 

Audio and then Audio on my 

PC. Then you browse on your 

computer for the audio file and 

select insert in that dialogue box.  

The playback bar that appears 

will disappear in presentation 

mode, until you hover over the 

speaker icon, at which point it 

reappears to give you control 

over the playback.

Diagram 39

You can isolate the part of the 

listening file you want to play.  As 

long as you have the audio playbar

bar clicked, the audio tools bar is 

showing. Choose the Playback tab.  

From this menu/ribbon choose Trim 

Audio.  Move either the start 

(green) or end (red) sliders to 

select the portion you want to play 

and then click ok.  

26

NB: It still plays all of it until you 

are in presentation mode.   



You can now choose to have your 

audio playing across more than one

slide too.

1.Select the icon for the sound file on 

your slide.

2.From the Animations tab, locate 

the Effect Options button and click the 

More Arrow below it to Show 

Additional Effect Options.

The Play Audio dialog box will appear.

3.Ensure the Effect tab is selected, and 

from the Stop playing section, select 

After and then use the up and down 

arrows in the slides field to indicate for 

how many slides the audio should play.

Advanced options for audio files
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You can also decide how to start playing the audio file.

1.Follow steps 1 and 2 above.

2.Select the Timing tab.

3.From the Start drop-down menu select On Click.

4.From here you have two options. If you would like the sound to play 

by clicking anywhere on the screen, say after a title appears, then 

select Animate as part of click sequence. Just be sure if you select 

this option, that you properly arrange the sound on the Custom 

Animation pane so that it begins in the desired order. If you do not 

want the sound to start at a specific time, but rather by clicking a 

specific object, select Start effect on click of and then choose the 

object that will trigger the sound from the drop-down menu.

NB: If you would like to be able to click the sound icon on your slide 

during the presentation to start the audio, select the Audio 

Settings tab and ensure that Hide audio icon during slide show is 

not selected. 



Inserting video into PowerPoint 2013

There are two ways to include video in your PowerPoint resources.  

You can embed or link to the video file.  If you embed the video, 

your file size increases (a lot) but the video clip becomes part of the 

PowerPoint and cannot be lost.  If you link to the video clip, the file 

size remains small but the link can be broken, (and if you email the 

PPT the video clip does not go too).

There are 2 methods here.  Either go from the Insert menu, choose 

Video and then Video on my PC. Then browse on your computer for 

the video file and select insert in that dialogue box.  The playback 

bar that appears will disappear in presentation mode but reappear 

when you hover over the clip. You can then control playback in the 

same way as audio files. 

To embed a video clip

You will often want to re-size the video.  Use the corner handles to do 

this and position the video image where you want it on the slide.

Alternatively,  use a slide format 

like this and click the ‘insert media 

clip’ button. In this case the video is 

usually already the correct display 

size.

Diagram 40

Diagram 41
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Link to training video on inserting video into PowerPoint.

You can isolate the part of the video file you want to play.  Click on 

the video clip and Video Tools appears.  Choose the Playback tab.  

From this menu/ribbon choose Trim Video.  Move either the start 

(green) or end (red) sliders to select the portion you want to play 

and then click ok.

To link to a media clip

Use either of the methods 

described already for 

embedding a video clip.  In the 

dialogue box  that appears when 

you locate your video file, 

instead of selecting ‘insert’ pull 

down the tab and choose ‘link to 

file’ instead. This gives you the 

same playback possibilities as 

embedding.  

1.  Trim Video

Playback / editing options

2.  Start video

The default setting is to start playback ‘on click’ but you can select 

‘start automatically’ if you click on the video clip, go to Video Tools, 

select Playback, then from video options pull down the tab next to 

‘on click’ and select instead ‘start automatically’.  

3.  Play ‘full screen’

Just below the ‘on click’ tab is a box that you can check for ‘full 

screen’ playback.

NB:  To check your file size, go to File  Info  Properties

29

Diagram 42

http://office.microsoft.com/en-gb/powerpoint-help/introduction-2-59-RZ102673174.aspx?CTT=1&section=2


To insert a video from the internet  e.g. YouTube

NB: This does not embed the video, it links to it, to play directly 

from the website.

Choose Insert and then 

Video.  Pull down the tab 

and select Video from 

website.  A dialogue box 

appears, into which you 

need to insert code.  To 

get the code you need to 

go to the location where 

the video is stored.

Underneath the video 

clip on the website, select 

the Share button.  Go 

down to the Embed 

option and check the ‘use 

old embed code’ box.  

Select and copy all of 

the code and paste it into 

the dialogue box in your 

PPT presentation.  You 

will be able to control 

playback in the same 

way as all of the other 

options to insert media 

clips.

Diagram 43

Diagram 44

NB:  You may still find it useful to download video from websites 

and for this I recommend www.keepvid.com 30

http://www.keepvid.com/
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Section 4:  Practising new language in reading
Reading activities can be presented using PowerPoint too.  The advantages to this 

are that the whole text can be displayed for whole class work first, or to illustrate 

the activity or begin with an example.  Various literacy or grammar focused 

activities can benefit from having a whole class large version of the text on display.  

In addition, the benefits to be gained from having the answers and marking scheme 

appear visually for the class are obvious.  There are no particular new skills to learn 

for the making of reading activities, although as we have concentrated so far on 

inserting pictures and sound, it seems like a useful point to include some general 

pointers about inserting and animating text in PowerPoint.

1.  Using a new slide with blank format, draw a text box by selecting Insert 

then Text Box and then clicking and dragging it out on your slide.  

Diagram 45

Diagram 46

As you can see, you do not have to type out 

the text, students can refer to the text book, it 

may be just the answers you want to focus 

their attention on using PowerPoint.  The 

second slide shows you the finished activity.  

To make the True/False answer boxes

appear, create them using a small text box, 

format them and then animate their 

appearance in the same way as you did for 

the pictures.

Write the text of the question or 

statement into the box and select the 

font and size that you want.  To add a 

colour fill to the box, select the text 

box and then click on the paint tin (top 

right) and select a colour in the usual 

way.  If you want a coloured outline to 

your box, select the colour from the pen 

icon.  Then copy and paste this text 

box, editing the text to create all the 

questions you want



2.  If you have questions in 

the TL (or English) that 

students need to answer, 

one neat way to present 

them is to have the 

answers appear over the 

top of the questions.  

To do this, create the 

questions slide first.  It is a 

good idea to save this 

slide as it is and make a 

duplicate to put the 

answers on as you may 

want to print the question 

sheet out and reduce to 

A5 size for the students.

Then on your duplicate 

slide, make a copy of the 

first text box and colour 

fill it a different colour.  

Type the answer in and 

animate it to appear. Then 

position the answer text 

box over the question one 

so that it fits exactly.  Now 

do the same with the other 

boxes so that all the 

questions are covered by 

answers.  

Diagram 48

When you play the presentation, 

the questions will be on the slide 

and the answers will reveal 

themselves over the top on your 

mouse click.

Diagram 47
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3.  These techniques can also be used 
to good effect for eliciting language 
orally from students, either by 
presenting the sentences mixed up, 
or just with the first letter of each 
word, and then having the full 
sentence appear over the top.

Diagram 49

Diagram 50 Here are a few more examples of 

using reading slides in PowerPoint 

presentations.  Where individual work 

is desired, these slides can be printed 

off and reduced to A5 size.  If point 

20 font size is used in the presentation, 

reduction to A5 works well for students 

to read.
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Section 5:  Practising new language in writing

Finally, I have a few examples of how PowerPoint can be used to 

present, explain and shape writing activities to improve pupil 

achievement in and engagement with writing tasks.
1. Plenaries

Here is one example of a slide 

used to elicit written opinions 

about food at the end of  a 

lesson introducing and 

practising the new language.  I 

sometimes do these plenaries 

using mini whiteboards, 

although they work equally 

well in exercise books. Students 

write something like:

A further example of a plenary 

from a lesson practising opinions 

and school subjects.  students 

had previously encountered 

these three connectives and 

were encouraged explicitly to 

use them to form longer 

sentences using the new opinions 

structures and school subjects.

Diagram 51

Diagram 52

1.  J’aime l’ananas parce que c’est bon pour la santé.

2.  Je déteste le lard parce que c’est trop gras.
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2.  Assessment for Learning

Once per half-term, students 

complete a writing activity that 

is set up carefully and 

explained using a ‘tick grid’ of 

quality of language items that 

are appropriate for each level 

during each year of each key 

stage.  The tick grid is used 

with students prior to 

completing the task to make 

explicit the aspects of 

language that would make an 

excellent answer.  

A further way to increase levels of 

engagement and improve performance in 

writing is to show scanned examples of 

pupil work, either from students within the 

class, or from a bank of excellent pupil 

work from the same year group or level 

that has been saved in a portfolio.  

3.  Showing pupil work

Diagram 53

Diagram 55

We then use the tick grid to mark 

the first draft of the work.  students 

complete a second draft of the 

piece, paying attention to those 

elements that they have not 

included or included unsuccessfully.  

Their second draft is then awarded 

a NC level or GCSE grade 

depending on the Key Stage.

This can be done with writing 

questions at all levels from 

beginners to A level.

Diagram 54
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The Animation Painter was one of the new features in PowerPoint 

2010 and is also in 2013.  The Animation Painter allows you o 

copy the animation effects of one object (and all the settings 

applied to that animated object), to another object (or many 

objects) with a single click of the mouse on each new object. This 

feature is a real time saver .

Select the slide which contains the animation you wish to copy.

Click on the Animations tab.

Copy animation to ONE Object

1.  Click on the object that contains the desired animation. 

2.  In the Advanced Animation section, click on the Animation 

Painter button. Note that the mouse cursor now changes to an 

arrow with a paint brush.

3.  Click on the object to which you wish to apply this same 

animation.

This animation and all its settings has now been applied to the new 

object.

Copy animation to SEVERAL Objects

1.  Click on the object that contains the desired animation. 

2.  In the Advanced Animation section of the ribbon, double click

on the Animation Painter button. Note that the mouse cursor now 

changes to an arrow with a paint brush.

3.  Click on the first object to which you wish to apply this same 

animation.

4.  Continue to click on all objects that require the animation.

To turn the animation painter feature off, click the Animation 

Painter button once again.

Best new features
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Why would you want to do this?

1.  The WMV video file format can be read by most computers.

2.  Any transitions, animations, sounds and narration will be 

embedded into the video.

3.  The video can be published to a website or emailed. It is not 

editable, so the entire presentation will always remain as the 

author intended.

4.  You can control the file size of the video by selecting 

appropriate options.

5.  The targeted audience does not need to have PowerPoint 

installed on their computer in order to view the video.

Best new features

Convert your PowerPoint presentation to a 

video.

How do you do it?

1.  Choose File  Save & send Create a Video

2.  Then choose your settings:

a.  Computer & HD Displays - Use this default 

setting if you are going to display this slide show 

with a projector on a screen for an audience. 

b.  Use Recorded Timings & Narrations - Either 

retain any timings you have added or the default 

settings will be assigned.

c.  Seconds to spend on each slide - By default this 

setting is 5:00 seconds. You may make a change 

the timing.

d.  To accept these settings click on the Create 

Video button.
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